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1. Welcome to TimeManager 

1.1. TimeManager Overview 
TimeManager is a full-featured time and expense billing system designed to perform the 
core business functions necessary to log fees and expenses for a successful service 
business. Data within TimeManager is maintained in fourteen main data files:  
 

1. CLIENT Contains information on a client or individual, including contact details, 
active status and referral source. 

2. CONTACT Contains information on related persons that are connected to the 
client account such as opposing counsel, expert witnesses, claims adjustors, etc. 

3. MATTER Contains names of specific matters, cases or projects that are related 
to client work. 

4. TIMEKEEPER Contains the information on each member of the firm or company 
who bills for time including timekeeper name, number, ID, assigned matters and 
billing rates. 

5. ASSIGNMENT Contains information regarding the different matters that the 
various timekeepers have been assigned 

6. SLIP contains time/expense records made by timekeepers. 
7. TRANSACTIONS Contain the records of payments made to the firm or company 
8. INVOICE Contains records of all monies owed by clients. 
9. PAYMENT Contains information on payments by invoice number, check, 

payment date, check number, customer number and amount 
10. ACTIVITY Contains all categories of services rendered by the firm such as 

meetings, travel, document review, depositions and court appearances. 
11. EXPENSE Contains all categories of expense charges such as copies, faxes, air 

travel, courier services and photo services. 
12. ABBREVIATION Contains time-saving shorthand entries for frequently used 

terms that are entered by timekeepers in the notes field of slips, such as TC for 
“telephone call”. 

13. RETAINER Contains records for all client funds on deposit with the firm or 
company. 

14. REFUND Contains information on refunds due to clients. 
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1.2. TimeManager Features 
 

• Generates professional invoices on a one-off basis or by the hundreds 

• Capable of generating single-matter as well as multi-matter invoices 

• Creates LEDES electronic invoices  

• Provides management and activity reports to analyze productivity and profitability 

• Works with leading third-party accounting systems 

• Uses sophisticated unattended backup system in multi-user environment to 
safeguard billing data 

• Sophisticated password system for multi-level access 

• Accessible from anywhere in the world over the internet using your private cloud 
 
 

1.3. System Requirements 
• Operating System: TimeManager requires XP, Vista, Windows 7 or Mac OS X.  

• Memory: A minimum of 2 GB is required, 4 GB of RAM is recommended. 
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2. Setup 

2.1. Installation 
Download the application from   www.atlantic-associates.com    website. 

2.2. Starting TimeManager and Logging In 
 
For PCs: Double-click on the blue 4D shortcut on the desktop. For Macs, double-click the 
4D icon in the Dock at the bottom of the desktop. The Login dialog box (Figure 2.1) will 
appear prompting you to sign in. 
 

 
Figure 2.1 

2.3. Table Selection Palette 
Once a user logs in, the Table Selection Palette (Figure 2.2) will automatically appear.  The 
Palette allows you to navigate between the different categories of information. Clicking on a 
particular table name will open a window containing all the records in that category.  
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Figure 2.2 

Click on any of the tables on the palette and a List View of the selected table will be 
displayed. 
If you accidentally close the Palette, go to “Tools” on the menu bar and select “Navigation 
Palette” and the Palette will reappear. 

2.4. System Defaults 
Much of the functionality of TimeManager can be customized to suit the practices of your 
particular firm by setting your own system defaults. For example, if you wish to change the 
type of information that is automatically displayed on invoices, you can enter your 
preferences in the Set Up window.  

Note: Only the Administrator can determine System Defaults. You must be logged in as an 
administrator to access the Set Up window. 

To manage the System Defaults, click File on the menu bar and select Administration. The 
Administration Options window will appear. Select Set Up. 
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The Set Up window contains six tabs:  

• Invoices This tab allows you to customize which information will appear on the 
invoices your firm generates. All of the items that are presently checked will 
automatically appear on all invoices. To modify your invoice default settings, check 
the features you wish to add and uncheck the ones you wish to delete. Click the 
Save icon when complete to save the new settings. Note, there is a box for you to 
input your firm’s Federal Tax ID if you wish to provide this information to your clients 
on your invoices. 

• Web This tab is used to enable remote access to TimeManager on a web-enabled 
device such as a smart phone or tablet. Contact Atlantic Associates to determine the 
proper values to enter in this tab.  

• Aging Under this tab, you can set the time periods that determine the “age” of an 
invoice. For example, if your firm sends a first reminder on all invoices that have 
gone unpaid for 45 days, you can enter “45” as Aging Period 1. If your policy is to 
send a second reminder after ten weeks, you can set Aging Period 2 at “70.”   To 
change the aging periods, simply enter the new number in the appropriate box. 
TimeManager can set up to six aging periods, but it is not necessary to use all of 
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them. If you wish to divide all invoices by four aging categories, leave boxes 5 and 6 
set at zero. Once you have made the desired adjustments, click on the Save icon to 
save.  

• Interest This tab allows you to set default parameters for charging interest. See 
Chapter 12 to learn more about interest.  

• Diagnostics This tab is used for troubleshooting in the event of a network problem. 
Leave these values as they are. You will only need to change them when dealing 
with customer support. 

• Gateway This tab enables TimeManager to process payments via credit card. 
Contact Atlantic Associates if you wish to activate this functionality. 

  

2.5. Users & Passwords 
To add a new user, click File on the menu bar and select Administration… from 
the drop-down menu. The Administration window will appear. Select Password 
Editor and click the OK button. 
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The Passwords window will appear. Click on the new user icon.  
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The Edit User window will appear. Fill in the user information and select the 
password options. Click OK to save the user information. The new username will 
appear on the Users list.  
 

 

Note: Only administrators can create new users. Administrators can create new users for only the 
groups they oversee. To create a new user who is a member of all groups, each group 
administrator must login and follow the process above.  
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• To assign the new user to a group, click File on the menu bar and select 

Administration from the drop-down menu. The Administration window will appear. 
Select Password Editor and click the OK button. The Passwords list view will 
appear. Select the user name from the list on the left and drag it to the Group list on 
the right and drop it on the relevant group name. Once the new user is assigned to 
at least one group, an expand button should appear next to the user name. Click on 
the expand box to view the user’s groups 

• To create a new group, click File on the menu bar and select Administration from 
the drop-down menu. The Administration window will appear. Select Password 
Editor and click the OK button. The Passwords list view will appear. Click on the 
new group icon 
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The Edit Group window will appear. Enter a new group name and assign a group 
owner from the drop-down menu.  
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By default, group members will have the ability to add, edit, view and delete all 
information. To limit the group’s authorization, select the information category you 
wish to restrict and uncheck the boxes for the functions to which they should not 
have access.  

• To delete a user click File on the menu bar and select Administration from the drop-
down menu. The Administration window will appear. Select Password Editor and click 
the OK button. The Passwords list view will appear. Select to highlight the user name 
from the list on the left and then on the right drag the selected user from their assigned 
Group to the trash can below.  Do the same on the right with the User Name.  

• Entering Timekeepers 
The people who will be logging time and expenses with TimeManager are considered 
Timekeepers. To add a new Timekeeper, click File on the menu bar and select Open Table 
from the drop-down menu. The Table selection dialog window will appear. Select 
Timekeeper. 
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A list view of Timekeepers will appear. Click on the new record icon on the top left corner. 
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 A new Timekeeper form will appear. TimeManager will automatically assign a Timekeeper 
number to the individual. Fill in the First and Last Names, Username (this must be their first 
and Last name), Classification (i.e. partner, associate, outside counsel), ID and the various 
rates that are billed for this individual’s services. Click the Save icon to save the record. 
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2.6. Activities 
To create a listing of Activities that will be used on the billing slips, click on the Menu bar 
File > Open Table.  A window will appear with a list of tables. Select Activity: 
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A List View window of activities will appear. To enter a new Activity, click the Add icon on 
the top left corner of this window. 
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An Activity Form View window will appear. Enter in the name of the new activity and the 
associated rates if appropriate. Once the form is complete, click on the Save icon to save 
the record. 
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2.7. Expenses 
To customize the list of Expense items, click on the Menu bar File > Open Table.  Select 
Expense from the list of tables that appears in the pop-up window. 
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A list view of existing Expense items will appear.  To enter a new Expense click the Add 
Record icon in the top left corner: 
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The Expense Form View will appear. Enter expense description, price and any relevant 
notes. When the record is complete, click the Save icon to save the expense. 
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Tip: For firms that file more slips for expenses rather than for time, it makes sense to change the 
settings so that each new slip automatically appears in expense format. See instructions below. 

 
To set the default slip type to expense, select from the menu bar File > Preferences. 
The Preferences window will appear. Select the Data Entry tab: 
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Set the radio button for Default Slip Type to “Expense.” All new slips will automatically be 
displayed in expense format. 
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To file a particular slip for time, without changing the default settings, simply click the 
“Time” radio button next to “Slip Type” on the new record as shown in Figure 

 

2.8. Abbreviations 
 
To save time, create abbreviations for common words and phrases that Timekeepers will 
use frequently when filling in new slips.  
 
To create a new abbreviation, click File > Open Table from the drop-down menu. A 
window will appear with a list of tables. Select Abbreviation 
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The abbreviation list view window will appear. Click the Add record icon on the top left 
corner. 
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In the Token field, enter the abbreviation and put the fully expanded word or phrase as you 
wish it to appear on invoices, in the text window. Click on the Save icon to save the record. 
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Once saved, the abbreviation will work immediately. Upon entering the abbreviation in a 
slip note box, the word will auto-complete as soon as the user touches the space bar.  
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3. Clients 

3.1. Adding Clients 
To add a new client, click the Client button on the Palette. The Client list view window will appear.  
Click on the New record icon on the top left corner.  

 
The Client New Record form will appear. Fill in the client name. TimeManager will assign a Client 
number.  Enter the client’s contact information. After entering the client’s city, TimeManager will 
automatically look up and input the zip code. If you have any relevant notes you wish to enter about 
the client, click the Note tab and enter the text in the box below. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 35 of 195 

 
 Once all the information has been stored, click on the Save icon to save the record. 

3.2. Viewing, Sorting and Searching Clients 
Viewing To see all of your firm’s clients, click the Client button on the Palette.  

 
The Client list view window will appear. The top of the window will indicate the number of 
clients stored in the database. Drag the scroll bar on the right to see all the clients. Double 
click on the client’s name to open a client record. When you are finished viewing the 
clients, click the Cancel icon to close the record.  
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This will return you back to the client list view window. 
Sorting By default, the clients are listed in A-to-Z alphabetical order. If you wish to sort the 
clients in a different manner, open the client list view window by clicking Client on the 
Palette. Click on the AZ icon on the task bar.  
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The sort window will appear.  

  
The Sort by drop-down window will allow you to choose by which category you sort the 
clients (by name, by client number, by billable hours, etc) and the ascending/descending 
radio buttons will allow you to determine the order. For example, you may wish to sort your 
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clients according to balance due and have those with the highest balance appear at the top 
of the list view. To do this, select “Balance” in the drop-down menu and click the 
“Descending Order” radio button.  
Searching To search for a particular client, click the Find icon on the task bar. The Find 
window will appear.  

 
The first drop-down menu on the left side of the Find window allows you to choose by 
which category to search for the client (by name, city, billable hours, etc) and the drop-
down menu in the center of the window allows you to determine how to search. For 
example, if you were searching for a client and cannot recall the exact name, but know that 
it is a trust and that the last name starts with S. To find this client, select “Client” in the first 
drop-down menu and “contains” in the second drop-down menu. Input “Trust” in the text 
box. Now click Find.  
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A search results window will appear. 
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To further narrow the search, click the Find icon again. Select “starts with” in the center 
drop-down menu and input “B” in the text box on the right. Select the “Search selection” 
radio button and click Find. 

 
TimeManager will now search only the clients with “Trust” in the name and return a list of 
those whose name begins with S.  
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3.3. Modifying Clients  
To add new information or to change information about an existing client, click the Client 
button on the Palette. The Client list view window will appear. Select the client you wish to 
modify by double-clicking on the client name. The Client Record window will appear. On 
the top half of the form you can add or change the client’s contact information, general 
status and Active/Inactive status. 
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The bottom half of the form displays tabs that will contain more in-depth information about 
the client (contacts, matters, rates, invoices, etc.). By clicking on a particular tab, such as 
Contacts, for example, you can add new contact people associated with that client. See the 
chapters ahead for adding Contacts, Matters, Rates, Slips, Invoices, Retainers, etc. 
 
To add a note on a client, select the Note tab on the bottom half of the form. Enter the note 
in the text box that appears. Select spell check if you desire. Once the note is complete 
and you have no other modifications to make to the client record, click the Save icon to 
save.   



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 43 of 195 

 

3.4. Deleting Clients 
To avoid having “orphan” data in your database that could cause confusion and accounting 
errors, TimeManager will not allow you to delete a client without first deleting all the 
transactions associated with that client.  
To find a client’s transactions, click Payment on navigation palette, 

 
The payment list view window will appear. Click on the Find icon  
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The Query Editor window will appear. Scroll down until you see “Client” in the Table 
column and “Client” in the Field column and select that row.  

 
A pop-up window with a list of all client names will appear. Select the name of the client 
you wish to delete. Once you see the client’s name appear in the Value textbox, click the 
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Find button on the bottom right corner. The Payment list view window will appear. Click on 
any of the payments. The payment record window will appear. Click on the Transactions 
tab  

Click the Delete All button. Now that all transactions associated with that client have been 
erased, you can proceed with deleting the client record.  
Click Client on the palette to open client list view. Click the Find icon to search for the 
client you wish to delete. The client list view will appear. Click on the client name to 
highlight it. Click the Delete record button on the task bar. 
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A window will appear asking you to confirm the deletion. Once you select Yes, the Client 
will be deleted.  



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 47 of 195 

4. Contacts 

4.1. Adding Contacts 
Contacts are the people associated with a client. They may be an individual client or the employees 
of the client company, or they may be people who work outside the client company but who have a 
connection to your work with the client such as opposing counsel, insurance claims officer, expert 
witnesses, trial exhibit suppliers, etc.  

 

Note: You cannot add a new contact without first opening an existing client record. 

To add a new contact, first open the client’s record by clicking Client on the Palette and selecting 
the desired client from the Client list view window. Click the Contact tab (it may already be 
selected) and click the +  button.  

A new contact record will appear. Enter the contact information and any relevant notes. If this is the 
main person with whom your firm will do business, check the Primary box. Once you have 
completed the form, click the Save icon on the task bar to save the record.   
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5. Matters  

5.1. Matters Defined 
Matters are the individual cases or projects that the firm is handling for a client (Smith vs. 
Jones, Estate of Stanley B. Schmidlap, 150 Main St. Development). A client may have 
more than one matter, but every matter must be associated with an existing client.   

5.2. Adding Matters 
To add a new matter, go first to the client to whom the matter belongs by clicking Client on 
the palette and selecting the desired client from the list view window. The client record 
window will appear. Click on the Matter tab on the bottom half of the window. 

 
Click the + button. A Matter: New Record window will appear.  The client field will 
automatically contain the client’s name. Assign a name to the matter in the Matter field. 
Enter the start date of the matter by clicking on the arrow box next to the date field. If the 
matter is ongoing, leave the end date as “00/00/00.” Once you have entered all basic 
information on the matter, click on the Save icon to save the record. 
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5.3. Assigning Timekeepers to Matters 
Once a new matter is created, you must assign at least one Timekeeper to the matter in 
order to be able to create slips (billing).  
To assign a particular Timekeeper click the + button the bottom half of the Assignment 
form.  
An Assignment New Record window will appear. Click on the Full Name field drop down 
arrow. 
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A List window will appear. Scroll down until you find the client whose matter you will 
assign to this Timekeeper. Highlight the client name and click the OK button. 
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I

 
If you wish to allow all Timekeepers in your firm to be able to write slips on a particular 
matter, you can save time by adding them all in one step: 
 
Open the Client record and select the Matter tab. Double-click on the desired matter. The 
Matter Record window will appear. Click on the Assignments tab (it is likely already 
highlighted). Click the ALL button. 
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TimeManager will automatically add all your firm’s Timekeepers to the matter.  Click the 
Save icon to save. 
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6. Billing Rates 
TimeManager can produce slips based on three different types of billing rates: 

• Timekeeper Rates whereby the client is billed according to the rate of the practitioner  
• Client Rates whereby the client is billed according to a rate customized for that 

particular client 
• Activity Rate whereby the client is billed according to the rate for the activity performed 

 
A firm can use all three types of billing rates and can even use different billing rates for a 
particular client. 
 
Since most of your firm’s billing will likely be of one type, you should set that rate type as 
the default using the following steps: 
Click File > Administration…  from the menu bar.  Select Set Up and click the OK button. 
The Set Up record window will appear. Click on the downward facing arrow in the field 
labeled “Client Rate” on the bottom right corner. 
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A list will appear with three options: Timekeeper, Client and Activity. Select the desired 
default billing rate type and click the OK button. The rate type should now appear in the 
text box on the bottom right corner of the Set Up window.  
 
In the case where you need to use a different type of billing rate than your default rate, you 
can change the rate type in the individual Client record. For example, if your firm’s default 
billing rate type is Timekeeper, but you are working on a matter that will require Client rate 
billing, open the client record and click on the Rate tab. The Rate table will appear on the 
client record. Click on Client Rate Type and a pop up list will appear. Select the rate type 
you wish to apply to the Client. Click on the Save icon to save the new rate setting. 

 

6.1. Timekeeper Rates 
To set rates for your Timekeepers, click File > Open Table on the menu bar. Highlight 
Timekeeper and click the OK button. 
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The Timekeeper List View window will appear. Double-click on the timekeeper whose rates 
you want to set. The Timekeeper Record window will appear. Enter the Timekeeper’s rates 
in the boxes on the right. Click on the Save icon on the task bar to save the new rates.  

6.2. Client Rates 
To set the rate for which you will charge a particular client, open the client’s record by 
clicking Client on the palette and selecting the desired client from the list view. Once the 
client record is open, click on the Rate tab. 
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The client record will now show a six text boxes where rates can be determined. Enter the 
rates you wish to charge the client, beginning with Rate 1. It is not necessary to set all six 
rates. Set as many as you need and leave the remaining ones at 0.00. Once all the rates 
have been entered, click on the Save icon to save the record. 
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6.3. Activity Rates 
To set rates for a particular activity, click File > Open Table from the drop-down menu. 
Highlight Activity and click the OK button.   
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The Activity list view window will appear. Double-click on the activity for which you wish to 
set a rate.  
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The Activity Record window will appear. Enter the desired rates beginning with Rate 1. It is 
not necessary to set all six rates; leave the unneeded rates set at 0.00. Once you have set 
all the desired rates, click on the Save icon to save the record. 
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7. Flat Rates 
In addition to hourly billing, TimeManager can also produce flat fee invoices on both a 
client or matter basis.  
 

Note: If separate accounting and invoicing history for each client matter is required you must 
establish multiple Client records so that distinct accounting can be maintained for each matter. If 
not required then use the Matter Based Flat Fees. 

To establish a Flat Fee billing arrangement, make sure that you have created a matter for 
the client. After you have created the matter, open the Client Record and click on the 
horizontal scroll arrow until the Flat tab appears. Click the Flat tab. 

 
The Flat Fee Configuration options will appear on the bottom half of the client record. See 
Chapters 7.1, 7.2 and 7.3 for an explanation of Flat Fee Type, Flat Fee Duration and Flat 
Fee Coverage. 
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Once you have selected Flat Fee Coverage, Duration and Coverage, you will automatically 
be returned to the client record where you can enter the Flat Fee amount. You may also 
enter any notes, such as why the flat fee is being used, in the message box below the fee 
amount. Once you have entered all the information, click on the Save icon to save the flat 
fee settings. 
 

7.1. Flat Fee Type 
Once you click on the Flat Fee Type box, a window will appear offering you a choice of Flat 
Fees.  
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• None means no flat fee to be used. 
• Absolute means a flat fee will be invoiced regardless of the actual charges. 
• Minimum means a flat fee charge will be invoiced regardless how small the real 

charges are. If the real charges are greater than the flat fee amount, then the real 
charges will be invoiced. 

• Maximum means a flat fee will cap the invoiced charges; the real charges will be 
invoiced up to the maximum figure and no higher. 

• Base means a flat fee is a basic charge and will always be added to the charges on 
slips. 

• Contingency means slips appear on the invoice, but there is no cost to the client 
until the status of the fee is changed to Final Bill. At that point, you can determine 
the amount to be invoiced to the client based on the accumulated slips, a flat fee 
amount of your choice, or a percentage of either amount. 

• Minimum hours means an absolute flat fee will be charged for a specified number 
of hours worked, then an hourly rate will be applied to slips beyond the specified 
threshold. If the hours threshold is not reached, an option determines whether you 
will charge the entire flat fee or a prorated amount. This type of flat fee only works 
with time charges and not expenses. 
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Select the flat fee type you desire and click the OK button. You will next be prompted to 
choose the Flat Fee Duration. 

7.2. Flat Fee Duration 
Once you have selected a flat fee type, you will be prompted to choose a Flat Fee 
Duration. 

  
• Select unlimited if you want the flat fee to be charged each time an invoice is 

printed. Monthly retainers can be adjusted to charge a flat amount on each invoice. 
• Select limited if you want the flat fee to be charged on each invoice for a 

predetermined number of invoices. The amount of times that the invoice will be 
created is set in the Flat Fee Invoice Field. 
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7.3. Flat Fee Coverage 
Once you have selected a flat fee duration, you will next be prompted to select the Flat Fee 
Coverage.  

 
• Services Only means the flat fee is for time charges on the invoice. Expense 

charges are calculated directly from expense slips. 
• Expenses Only means the flat fee covers only expense charges on the bill. The 

time charges are calculated directly from the time slips using hourly billing. 
• Services & Expenses Combined means the flat fee is for time and expense 

charges. The invoice shows only one line of totals for both charges instead of one 
for each. 

• Services & Expenses Separate means the flat fee covers both time and expense 
charges as separate amounts. This permits you to keep an internal record of the 
timekeeper’s activity history and allows you to calculate the true cost of the work 
performed under the flat fee. 
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8. Slips 
A slip is a record of work performed for a client. It can also be a record of an expense 
incured on a client’s behalf. Slips are for the internal use of your firm and do not appear to 
clients until you convert them into line items on an invoice.  

8.1. Entering Slips 
There are several ways to create a new slip in TimeManager.  
From the palette, you can simply click on Slip. 

 
The Slip List View window will appear. Click the new record icon on the left side of the task 
bar. 
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A Slip: New Record window will appear. Click on the downward-facing arrow in the Client 
field. A list window will appear. Scroll down until you find the client to whom you shall 
assign the slip. Highlight the client and click OK. You will be prompted to select a matter (if 
there is only one matter in the client’s record, the slip will automatically be assigned to that 
matter). You will next be prompted to select a timekeeper.  
 
You can also access a new slip from within a client record by clicking on the Slip 
tab.  
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Click on the + button on the left part of the form.  A new slip record will appear and you will 
be prompted to select a matter (if there is only one matter in the client’s record, the slip will 
automatically be assigned to that matter). You will next be prompted to select a 
timekeeper. 
If you are creating a slip for time worked, see Chapter 8.2 for further instructions. If you are 
creating a slip for an expense, see Chapter 8.3 for further instructions. 

8.2. Time Slips 
If you are filing a slip for time worked, your next step after filling in the client, matter and 
timekeeper information is to select the activity for which you are billing. Click the black 
downward-facing arrow in the Activity field. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 71 of 195 

 
A list window of activities will appear. Select the activity that describes the slip and click the 
OK button.  
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There are three different ways to enter your time worked. The first is to enter the hour you 
began in the Start Time field and the hour you quit in the End Time field. Use 24-hour time 
(e.g. for 3pm, enter 15:00, for 4:30 pm enter 16:30). TimeManager will automatically 
calculate the total hours in the field below.  
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You may also skip the Start Time and End Time fields and simply enter your total hours 
worked in the Billable Hours field (or Non-Billable Hours field if the slip you are filing is for 
non-billable work). 
 

Warning: If you use this method to enter your time, be careful to translate your minutes worked into 
a fraction (e.g. if you worked 4 hours and 30 minutes, you should enter 4.50 in the Billable hours 
field. Do not enter 4.40). If you are unsure how to calculate your fractional time, use the Start Time 
and End Time fields. 

 
To enter your hours using the TimeManager timer, see Chapter 8.4.  
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Once you have entered your hours, the billable (or non-billable) charges will automatically 
be calculated in the left-hand column. If you wish to make any adjustment to the charge 
(such as a discount, or a surcharge) you may enter it in the Adjustment 1 and Adjustment 2 
fields. Use the Notes field to enter in any description or explanation of the expense and/or 
any adjustments. This note will appear on the client’s invoice.  Once the time slip is 
complete, click the Save icon on the task bar to save the record. 

8.3. Expense Slips 
To enter a slip for an expense, follow the instructions described in Chapter 8.1. Once the 
Slip: New Record window appears, click the Expense radio button on the slip record.  
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Once you have selected the client, matter and timekeeper, you will be prompted to enter an 
Expense type from a list of options. If the expense you intend to file isn’t on the list, see 
chapter 2.8 for entering new expense items.  
 

Tip: If the majority of the slips you file are for expenses, rather than time, see Chapter 2.8 for 
instructions on setting your slip default type to “Expense.” 

 
For expense items with a fixed price, such as photocopies, the price will appear 
automatically in the price field. You need only input the quantity and TimeManager will 
calculate the total. 
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For expense items with a variable price such as meals, airfare or FedEx, you should input 
the total in the Price Adjustment field. Hit the tab key on your keyboard and the total will 
automatically appear in the charges column on the right.  
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If you wish to make any adjustment to the charge (such as a discount, or a surcharge) you 
may enter it in the Adjustment 1 and Adjustment 2 fields. Use the Notes field to enter in any 
description or explanation of the expense and/or any adjustments. This note will appear on 
the client’s invoice.  Once the expense slip is complete, click the Save icon to save the 
record. 

8.4. Using the Slip Timer 
TimeManager includes a timer function that can be used to track hours. This is especially 
useful if you take a break and want to resume your work on the assignment without having 
to calculate the total hours. 
 
To use the timer, click the clock icon. 
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A window will appear asking if the time is billable or non-billable. Once you choose an 
option, the clock will begin ticking.  When you are finished working, click on the clock icon 
again. The total time will appear in the Billable Hrs field (or the Non Billable Hrs field if you 
chose that option). If you intend to resume working on the same assignment, leave the 
record open and click on the clock icon again.   
 
The billable (or non-billable) charges will automatically appear in the right hand column.  
Click on the Save icon to save the slip. 
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9. Creating Invoices 
An invoice is a bill with a summary of charges that is sent to a client. TimeManager can 
produce an invoice as soon as the user creates a billable item (slip). Alternatively, invoices 
can be produced in a batch at the end of the day, week, month, etc. 

9.1. Invoice Single Matter 
To create an invoice for a single matter, click Client on the palette.  
 
The Client List View window will appear. Click on the Find icon to search for the desired 
client.  

Enter the first few letters of the client name and click Find. 
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The Client List View window will now show a reduced selection of client names. Click once 
to highlight the desired client and click the Create Invoice icon on the right end of the task 
bar. 
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The Create Invoices Dialog will appear. This window allows you to control which slips are 
included in the invoice on both a date and invoice number basis. If you wish to include all 
uninvoiced slips up to the present, leave the date range as 00/00/00 to the present date, 
otherwise, adjust the dates accordingly. Click OK. A processing window will briefly appear. 
Once it disappears, you can verify that the invoice was successfully created by clicking 
Invoice on the palette. 

 

 
The Invoice list view window will appear. The most recently created invoices will appear at 
the top. 
 

9.2. Invoice Multi-Matter 
To create an invoice for a single matter, click Client on the palette.  
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The Client List View window will appear. Click on the Find icon to search for the desired 
client.  

Enter the first few letters of the client name and click Find. 
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The Client List View window will now show a narrowed selection of client names. Click 
once to highlight the desired client. 
 

Warning: To create a multi-matter invoice, the “Multi-Matter Client” checkbox on the client’s invoice 
settings must be checked. To do so, click the Inv Set tab in the client record. 
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Click the Save icon on the task bar to save the settings and return to the Client list view. 

 
Highlight the client name and click the Create Invoice icon on the right side of the task bar. 
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The Create Invoices window will appear. This window allows you to control which slips are 
included in the invoice on both a date and invoice number basis. If you wish to include all 
uninvoiced slips up to the present, leave the date range as 00/00/00 to the present date, 
otherwise, adjust the dates accordingly. Next, click the Create Multi Matter Invoices radio 
button. 
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Click OK. A processing window will briefly appear. Once it disappears, you can verify that 
the invoice was successfully created by clicking Invoice on the palette. The Invoice list view 
window will appear. The most recently created invoice will appear at the top of the list. 
Double-click on the invoice to see more details. 
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9.3. Flat Fee Invoice 
Before creating an invoice for a Flat Fee client, you should adjust the invoice settings so 
that the printed invoice displays information relevant to a flat fee billing agreement. To 
change invoice settings, click the Inv Set tab in the client record. 
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Uncheck the boxes that are irrelevant, such as “Display Rate” or “Display Hourly Charges” 
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Once the Invoice Settings are saved, you can proceed to create an invoice. 
To create an invoice for a Flat Fee client, click Client on the palette.  

 
The Client List View window will appear. Click on the Find icon to search for the desired 
client.  
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Enter the first few letters of the client name and click Find. 

The Client List View window will now show a reduced selection of client names. Click once 
to highlight the desired client and click the Create Invoice icon on the right end of the task 
bar. 
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The Create Invoices dialog will appear. This window allows you to control which slips are 
included in the invoice on both a date and invoice number basis. If you wish to include all 
uninvoiced slips up to the present, leave the date range as 00/00/00 to the present date, 
otherwise, adjust the dates accordingly. Click OK. A processing window will briefly appear. 
Once it disappears, the invoice is complete. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 95 of 195 

 
To view the invoice record, click Invoice on the palette. Click on the newly created invoice.  
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The invoice record window will appear. Here you can see the actual time charges for the 
slips included in the invoice in the bottom right field. The top right field shows the client’s 
total charge (the flat fee).  
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9.4. Write-Offs 
In the event you need to write-off a portion or all of the services billed to a client, you will 
want to record it within the invoice. Open the Invoice Record and enter the amount of the 
write off in the appropriate field. 
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The balance will now reflect the adjusted amount (minus the write off).  

9.5. Invoice Settings 
Invoice settings determine what information is displayed on the invoices you print for 
clients. Invoice settings can be customized for each client. To adjust invoice settings, open 
the client record and click the Inv Set tab. 
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The Invoice Setting subform will appear. Click on any of the checkboxes to add that feature 
to the printed invoice. For an explanation of any feature, hold your mouse over the term for 
a moment.  A yellow text box will appear with an explanatory sentence. 
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9.6. Printing Invoices 
To print a single invoice, click Invoice on the palette. The Invoice list view window will 
appear. Click once to highlight the invoice you wish to print and then click the Print icon on 
the task bar. 
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The Report Manager window will appear. Select the desired invoice format from the list on 
the left and click Print.  
If you want to see how the invoice will appear before you send it to your printer, click the 
Preview button.  
You can print directly from the preview screen by clicking the printer icon, or you can 
cancel by clicking the Cancel button on the bottom right of the form.   

9.7. Emailing Invoices 
 
To email an invoice, you must convert it into a PDF document. Follow the same steps 
outlined in Chapter 9.5 Printing invoices. Once you click Print on the Report Manager, the 
Print options window will appear. 
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A new window will appear prompting you to save the document. Chose a name for the 
document and a folder where you will save it. Once saved, you can add the invoice as an 
attachment from your email account. 
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10. Payments 
 

10.1. Entering Payments 
To enter a new payment click Payment on the palette. 

 
The Payment list view window will appear. Click on the New record icon on the left side of 
the task bar. 
The Payment New Record window will appear. Select the client’s name in the Client field. 
TimeManager will automatically display all the invoices assigned to that client. Payments 
may be entered either as a single entry or by the dozens at a time in batch mode.  Enter 
the amount of the payment in the Amount field on the top right corner. You may also enter 
the check number in the Check No field and the check date. 
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10.2. Applying Payments 
After you have entered a payment from a client, you must apply that payment to an invoice 
or to multiple invoices in order to bring down the balance owed on those invoices. 
There are two ways to apply a payment: 
Manual Apply – This option allows you to apply the funds to a particular invoice. To use 
this method, double click on the invoice to which you wish to apply the funds. 
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A pop-up window will appear. You will be asked to determine how much of the payment 
you would like to apply to the selected invoice. The full payment amount will appear by 
default. Click OK if you would like to apply the entire payment amount to the invoice. 

 
After you click OK, the payment will appear in the Credit column on the Invoice form view 
and the invoice will display a new adjusted balance. 
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Auto Apply – This option will cause the funds to be applied against the oldest invoice and 
then to the next oldest invoice. To use this method, simply click the Auto Apply button in 
the middle of the Payment form view. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 107 of 195 

 
The payment will now appear in the Credited column. 
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10.3. Transactions 
Every time a payment is applied, TimeManager creates a record of that application of funds 
in the form of a transaction. To see how a particular payment was applied, click on the 
Transaction tab in the Payment form view. 
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If you should ever need to delete a payment, you must first delete the transaction. You 
can do this by highlighting the transaction and clicking the Delete One button, or by clicking  
Delete All if there are multiple transactions that you want to delete. 
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11. Retainers 
Retainers are funds given by a client to a firm to be used to pay for futures services and 
expenses rendered on behalf of the client. TimeManager can maintain multiple retainer 
accounts for a client. 

11.1. Creating a Retainer Account 
To establish a retainer for a client, open that client’s record and click on the Retainer tab on 
the bottom half of the client record. 

 
Click on the + button. The Retainer Input form will appear. Enter a name for the retainer 
account and enter the date it was created. Click on the Save icon to save the new retainer 
account. 
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11.2. Deposit to Retainer Accounts 
 
To fund a retainer, you must deposit funds to the firm by creating a payment record as 
shown in Chapter 10.1. Once you have created the payment, click on the Retainer tab.  
You should see the name of the retainer account you earlier created. Double click on the 
retainer. 
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A pop-up window will appear where you will be asked to confirm how much of the payment 
you wish to deposit to the retainer. Click OK. 

  
The funds will now appear in the Deposits column on the retainer.  
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11.3. Payments from Retainer 
Once the retainer account has funds in it, you will be able to apply those funds to an 
invoice.  To pay an invoice with retainer funds, go to the client record and click on the 
Retainer tab. Double-click on the retainer account. The Retainer subform will appear. 
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Double-click on the invoice you wish to pay with the retainer funds. A pop-up window will 
appear asking you to confirm how much you wish to apply to the invoice. Click OK. 
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The invoice will now show a credit and the retainer will show a lower balance. 

11.4. Auto Payment from Retainer 
 
TimeManager can apply retainer funds from a particular client automatically as that client’s 
invoices are created. To enable this function, go to the client record and click on the Inv 
Set tab. Check the Retainer Auto Pay checkbox and click the Save icon on the task bar to 
save the new setting. 
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12. Refunds 

12.1. Refunding a Payment 
To refund a payment, open the Client Record for the particular client to whom the refund 
should be applied. Refunds can only be issued if there is already a payment on record. 
Click the Payment tab to verify that a payment has been recorded.  (If there is no payment 
shown, you will first have to enter the payment before logging a refund.) 

 
Click the scroll icon on the right to advance the tabs. 
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Select the Refund tab to open a new Refund record. 
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Click on the + button to open a new refund record. Click in the “Pay Method” field to select 
how you will issue the client the refund (via check, credit card, wire transfer, etc.). If the 
refund is being paid via check, enter the check number and date. Enter the amount of the 
refund in the “Amount” field in the top right corner. Now double click on the payment to 
apply the refund. 
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A dialog box will appear asking you to confirm the amount of the refund. 

 
Click OK. The refund will automatically be applied to the payment.  
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12.2. Refunding a Retainer 
Note: To issue a retainer refund, the client must have money in the retainer account.  Open 
the Client Record for the particular client to whom the refund should be applied. Click on 
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the scroll icon to the right of the tabs to advance to the Refund tab. Click Refund. 

 
Click the + button to open a new refund record. The Refund: New Record window will 
open. Select a mode of payment for the refund in the Payment Method field (cash, check, 
etc.). Enter the amount of the refund in the Amount field.  
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Click on the Retainers tab. Click on the retainer that appear in the subform. A small dialog 
window will appear.  

 
If the amount of the refund is correct, click OK. Click on the Retainer tab in the Client 
record window to see the new retainer balance. The refund will appear under the 
“Withdrawals” column in the subform. 
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13. Interest 

13.1. Setting an Interest Rate 
TimeManager allows you to set an interest rate for unpaid invoices and to determine at 
what point that interest charges will begin accumulating. You can set interest in three ways: 
for a single invoice only, for a particular client only, or across the entire firm. 
 
To set an interest rate for a single invoice, click Invoice on the palette to open the Invoice 
list view. Select the invoice to which you wish to apply interest and double-click on it to 
open the record. Click on the Interest tab. 

 
The Interest subform appears on the bottom half of the record. Click on the Calculate and 
Charge Interest button at the bottom of the subform. An interest pop-up window will 
appear. Enter the interest rate, the number of days that must pass before an invoice incurs 
interest and the date from which the interest should begin accumulating. Click the 
Calculate Interest button. The resulting interest amount will appear in red.  
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To set an interest rate for a single client, click Client on the palette and double click on the 
client’s name in the list view window. The client record window will appear. Click on the 
Interest tab (you will need to click on the horizontal scroll arrow until the Interest tab 
appears).  
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The interest subform will appear in the bottom half of the client record. Enter the interest 
rate, the number of days an invoice must be unpaid before invoice is imposed and the 
number of days at which interest begins to accumulate. Click the Save icon on the task bar 
to save the interest rate. 
 
To set a universal interest rate that will apply to all your clients, click File on the menu bar 
and select Administration from the drop-down menu. The Administration window will 
appear. Highlight Set-Up and click the OK button. The Set-Up window will appear. Click on 
the Interest tab. 
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Enter the interest rate and select the number of days that must pass before an unpaid 
invoice incurs interest. You must also determine from when the interest should accumulate. 
Click on the Save icon on the task bar to save the interest rate.  
Note – every new client that you set up now will have these default interest values saved to 
their individual record. 

13.2.  Charging Interest 
Even though you have set the interest rate for an invoice, a client or your firm, the interest 
still won’t actually be added to invoices until you elect to charge it. 
 
A. To charge interest on a single invoice, click Invoice on the palette and double-click on 
the desired invoice. The invoice record will appear. Click on the Interest tab. Click on the 
Calculate and Charge Interest button at the bottom of the subform. 
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Click on the Calculate Interest button. The total interest will appear in red. Click on the 
Charge Calculated Interest to Invoice button. The balance on the invoice will automatically 
adjust to show the interest. 
 
B. To charge interest on all of a client’s invoices, click Client on the palette. Highlight 
the client in the list view. Now click Tools > Special Functions on the menu bar. The 
special functions window will appear.  
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Highlight Update Interest and click OK. The Interest Calculation window will appear. If you 
wish interest to be calculated up until the present day, leave the date unchanged, 
otherwise, change the date accordingly. Click Update Interest. 

 
Once the processing window disappears, you may click Invoice on the palette to search for 
the client’s invoices. Open one of the invoice records to verify that the interest has been 
charged. 
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C. To charge interest on all outstanding invoices from all of your clients, follow the 
same steps outlined above. You simply need to open the Client list view, highlight the 
clients to be charged interest and click Update Interest on the Special Functions window.  

Tip: Make sure all invoices are closed when you fun the Update Interest function. Any open 
invoices will not be updated. 
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14. Taxes 
 

14.1. Setting a Tax Rate 
To set a tax rate, click File on the menu bar and select Open Table from the drop-down 
menu. The TimeManager window will appear. Highlight Tax and click the OK button. 

 
The Tax window will appear. Click the Add Record icon on the top left corner.  
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The Tax New Record window will appear. Enter the type of tax (Federal, Provincial, State, 
ect.), the Basis (services, expenses, services and expenses) and the tax rate. Click on the 
Save icon on the task bar to save the tax rate. 

14.2. Charging Taxes 
To charge a tax, open the client record and click the Tax tab. Click on the Select Tax 
button. 
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A list window will appear. 
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Highlight the tax you wish to charge and click OK. The tax will now appear on the tax 
subform on the client’s record. Click the Save icon on the task bar to save the tax rate to 
the client’s record. All future invoices created for this client will include tax as shown. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 136 of 195 

 
 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 137 of 195 

15. Reports 
 

15.1. Report Editor 
TimeManager is capable of automatically producing dozens of different types of reports 
about your business, such as a list of all of a timekeeper’s clients or the total number of 
invoices generated in a quarter. The Report Editor is the screen that displays all the report 
options. You can also modify the report templates, such as changing the font, the sizing, 
the column header, etc. from within the Report Editor 

Warning: Many of these reports are code-driven and while you may have the ability to see and 
change the code, do not modify the code unless you have a very thorough understanding of the 
underlying database language. 

 To access the report editor, click Tools on the menu bar and select Special Functions 
from the drop-down menu. 
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15.2. Running Reports 
To run a report, you click on the Print icon on the task bar to see which reports are 
available for the table you are presently viewing. 
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For example, if you are looking at the Client list view, the report manager will display all the 
available client-related reports. If you are in the Invoice list view, the report manager will 
display invoice-related reports. Besides the tables on the palette, you can also open tables 
such as Timekeeper, Matter, Abbreviations, etc. using File > Open Table, to see reports 
relevant to those tables.  
 
By clicking on a report in the Report Manager, you can see a description of what 
information that report will display. 
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To run the report, click Preview.  
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Click on the printer icon to print a hard copy of the report or to create a PDF.  

15.3. Modifying Reports 
It is possible to make cosmetic changes to an existing report template, such as rearranging 
the layout of rows, or renaming the column headers. For example, a firm may wish to 
change the Timekeeper Slips for Period report to read as “Attorney Slips for Period.” To 
make this change, click Tools on the menu bar and select Special Functions from the 
drop-down menu. Click Report Editor. Select the report template you wish to edit (in this 
example, Timekeeper Slips for Period).  
The report template will appear in the main window. If you wish to edit the text in the 
template, click the element you wish to change.  
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A enterable text edit field will appear. Delete the text and retype the new text. 
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The report template will display the new text. If you are satisfied, click the Save Report 
Template button in the bottom right corner. Then click the Done button. 
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You can also move the text elements by clicking and dragging them.  

15.4. Creating Reports 
If you make changes to an existing report, but don’t want to overwrite the original, it is 
possible to create a new report. In the example shown in 14.3, after replacing “Timekeeper” 
with “Attorney” in the header, you should give a new title in the field Report Name and then 
click on the menu bar on File > Save As.  Give the report a name and save it to your 
computer. 
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When you wish to reopen the report, click on the menu bar File > Open and select your 
newly named report. 

 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 146 of 195 

16. Quick Report Editor 
 
The Quick Report Editor is a tool that allows the user to create custom reports for 
presentation purposes. While the Query Editor can search for data, it is the Quick Report 
Editor that puts that data into an easy-to-read format. Chapter 15 shows the example of 
running a query to find all invoices greater than $10,000 for clients in Massachusetts. You 
can now use the Quick Report Editor to arrange a list of those clients, along with columns 
such as address and total invoices. 

16.1. Creating a Quick Report 
A quick report can be created once you have run a query and the query results have 
appeared in a list view window. From the list view, click on the Quick Report icon. 

 
The Quick Report window will appear. Begin building your report by selecting the columns 
you want to display. Scroll down through the Master Table list to find the fields relevant to 
the report. Highlight and drag them to the gray bar area above. In this example, Client 
name, client city, billable hours and amount invoiced will be the displayed columns. To add 
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a title to the report, click File within the Quick Report menu bar and select Header and 
Footer from the drop-down menu.  

 
Enter the text you wish to display. You can adjust the font and style. You may also 
automatically add the time, date and page numbers by clicking on the icons on the right 
edge of the text fields.  

Tip: To allow dollar amounts to display properly in quick reports, enter the following mask notation 
in the Detail field below the amount column: $ ###.##0.00 

To sort the results of the report, select the field you will determine the order of the results. 
In this example, you may wish to sort the clients according to their total invoices amount 
from lowest to highest. To do so, highlight Invoiced in the Master Table and click the green 
button with the right-pointing arrow. [Client]Invoiced will now appear in the Sort Order 
window. Click on the upward pointing arrow to change it to point downward. This will 
instruct the Quick Report editor to display the clients in descending order according to their 
invoice totals. 
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Once all the inputs of the report have been determined, click File in the Quick Report 
window and select Print Preview from the drop-down menu.  
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 To print the report, or to create a PDF, click File from within the Quick Report window and 
select Generate from the drop-down menu. 
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17. Queries 
A query is a way of asking a question about your data. TimeManager answers that 
question by running a search of all the data much faster and more accurately than could be 
done manually. TimeManager has two methods of performing queries: the Find function, 
for simple queries, and the Query Editor, for more complex questions that involve several 
tables.  
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17.1. Simple Queries 
The Find function can handle simple queries such as 

• How many invoices do we have that are more than $10,000?  
• Which of are clients are based in New York? 
• How many slips did we file on March 22nd? 
• Which clients account for the most billable hours? 

To run a simple query, open the list view of the table you wish to query. For example, if 
your question is about client balances, click Client on the palette to open the Client list 
view. If you want to know see all invoices that were greater than $10,000, click on Invoice. 
 
Once the list view window is open, click on the Find icon on the task bar to open the Find 
window. 

 
Using the pop-up menus in the three variable fields, you can form a sentence that will 
instruct TimeManager what to search for in the data.  
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Using the radio buttons, you can limit how much of your data is included in the search. 

17.2. Query Editor 
The query editor is designed to handle more complex searches than the Find function. You 
can use the Query Editor when your search involves more than one table. For example, if 
you want to know how many of your invoices over $10,000 come from New York clients, 
that query would involve data from both the Invoice and the Client table. Only the Query 
Editor can perform this search.  
 
To launch the Query Editor, click the Find icon on the task bar in any list view window. The 
Find window will appear. Click on the Query Editor button on the bottom left corner. The 
Query Editor window will appear. To construct your query, search for one of the field you 
wish to determine. In this example, the first field is “Amount” from the Invoice table and the 
value is greater than 10,000. Scroll down to highlight the Invoice Amount row. Enter 10000 
as the value. Click the downward facing arrow below the value field to open the pop up 
menu. Select greater than. The summary window will now show the first part of your query: 
[Invoice]Amount >10000. 
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To add the second field, click the +And button. In this example, the second field is State 
from the Client table and the value is Massachusetts. Scroll through the list of Fields to 
Highlight Client St. Enter MA as the value. Click on the downward-facing arrow below the 
Value field to open a pop-up window. Select Equal to. The summary window now displays 
the full query. Click Find to run the query. 
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The results of the query will appear in a list view window. To learn how to convert the query 
results into a visual report, see Chapter TK Quick Report Editor. 
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18. Sorting 
Sorting is a quick and simple way to find data within TimeManager. With sorting, you can, 
for example, find all your clients arranged by city, or rank your invoices from highest to 
lowest. TimeManager has two different ways to sort data. 

18.1. Column Sorting 
Column sorting is a simple point-and-click means of arranging data. From any list view 
window, click once the column header of the column you wish to sort by. For example, if 
you are looking at a list of clients sorted in alphabetical order, but wish to see them sorted 
by client number, click once on the word No in the first column. To change the order from 
ascending to descending just click on the small triangle again and it will be resorted. 

 

18.2. Sort Editor 
If you want to sort your data according to a field that is not displayed in any of the columns 
in the list view, you can use the Sort Editor. From any list view, click on the AZ icon on the 
task bar. The Sort Editor window will appear. Click on the Sort by field to open the drop-
down menu and select the field by which you would like to sort the data.  



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 157 of 195 

 
Click on the radio button to determine ascending or descending order. Click the Sort 
button. The list view window will now display the data according to the sorting parameters 
you just selected. 
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19. Labels 
The Label Editor is a tool that allows the user to create custom label templates that will be 
automatically filled with client or contact address information.  

19.1. Label Editor 
To use the Label Editor, click Client on the palette to open the Client list view. If you wish 
to create labels for your entire client list, just click on the Label icon on the task bar. If you 
wish to create labels for just a select group of clients, first run a search using the quick find 
or query editor function. Once you have narrowed your client list, then click the Label icon 
on the task bar.    

 
The Label Editor window will appear. Select the fields you wish to include on the label from 
the List of Fields window on the left and drag them to the label on the right approximately 
where you wish for them to appear. For fields that should be printed on the same line, drop 
one field right on top of the other.  The label editor will automatically insert a + symbol to 
show that they will appear on the same line. Once all fields have been added, drag a box 
around the fields by holding down your mouse. You can click on the left justify icon to 
straighten the appearance of the fields. 
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Select a font size and style for your labels.  

Tip: You can save the label template to your hard drive by clicking on the Save button at the bottom 
of the window. When you need to use the label template again, click Load at the bottom of the 
Label window to open your saved file.  

Click on the layout tab to determine the size and orientation of the labels.  

19.2. Printing Labels 
Once you have set up the label template, click on the Print button on the Label window. 
The Print pop-up window will appear. Click the Preview button to see the labels populated 
with client data. Verify that your template includes the proper fields and will fit within the 
limits of the label. 



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 160 of 195 

 
If you are satisfied with the preview, close the preview window to return to the Print 
window. Choose your printer destination from the drop-down menu. Click the Print button. 
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20. Sets 
Once you have run a search or a query, you may want to save the results for future 

reference. When you save those results, you are creating a “set.” You can save an 
unlimited number of sets and you can use TimeManager’s Set Manager to compare your 
sets to isolate or consolidate data. For example, if you wanted to send letters to all clients 
with balances that were more than 90 days overdue, but wanted to make sure you didn’t 
include any clients who had an ongoing matter, you could do this by using sets.  

20.1. Creating a Set 
The simplest way to create a set is to manually click on the records you wish to include by 

holding down the control key (command key for Macs) which will highlight the records. You 
can also create a selection of records that you wish to become a set by using the Query 
Editor. Just like a manual search, the results of your Query will appear in a list view 
window.  
Now click Enter on the menu bar and highlight Add to set from the drop down menu. 

Select New Set from the window that appears adjacently. The New Set window will appear 
and you will be prompted to give a name to the set. 

 
Click the Save button.   
You can now add other records to the set at any time. To add a single record, highlight it 

in a list view and select Enter on the menu bar and highlight  Add to set  from the drop 
down menu. Highlight the set to which you wish to add the record. 
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To access your set, you must be in the same table. For example, if you have saved a set of 
invoice records that you wish to view, you must first click Invoice on the palette. If it is a set 
of client records you want to see, click Client first on the palette. From there, you can click 
Enter on the menu bar and highlight “Use Set” from the drop-down window. A list of your 
saved sets (for that table) will appear. If you clicked Client on the palette, you will only see 
Client-related sets, and not any Invoice-related sets. Once you click on the desired set 
name, a list view window will appear containing the set data. 

20.2. Set Operations 
Once you have created more than one set, you can run “set operations” which give you 
the power to consolidate or isolate data. For example, if you want to identify all clients who 
have unpaid invoices that are more than 90 days past due, but don’t want to include any 
clients who are incurring interest, you can use set operations to compile that list.  
 
To access the set operations function, click the Sets icon (an image of two intersecting 
circles) on the task bar of the list view window. 

 
The Set Manager window will appear. All of your existing sets will be listed under set name.  



TimeManager 4.0 
 

Document: TMManual 9.docx 11/9/2011  
 
 

  
Page 163 of 195 

Tip: If you do not see the sets you wish to use, you are likely in the wrong table. Close the set 
manager and the list view windows and click the appropriate table on the palette.  

Select the two sets you wish to compare by clicking on Set A and choosing one of the set 
names from the drop-down menu. Do the same with the Set B drop-down menu. In this 
example, Set A is Clients with balances more than 90 days past due and Set B is clients 
incurring interest. Assign a name for the new set that will be created once you run the 
operation. Click the Difference button to get a list of all records in Set A, minus any that 
also happen to be in Set B.   

 
The Set Manager will automatically run the operation and the results will appear as a new 
set listed at the top of the set list in the window on the left. To view the results, close the set 
manager and click Enter on the menu bar. Select Use Set from the drop-down menu and 
select the set as you named it in the Result field on the Set Manager (in this example, 
“Non-interest overdue balances”). 
 
Using the same sets, you could also find all clients with balances past due more than 90 
days who are also paying interest by clicking the Intersection button. You could also 
compile a list of all clients with 90-day past due invoices and all interest-paying clients by 
clicking Union. 
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Warning: When using the Difference operation, it is important to take note of which set you assign 
as Set A. In the above example, selecting Interest-paying clients for Set A, instead of Set B, would 
result in a list of interest paying clients with balances less than 90 days overdue (instead of the 
intended search: clients with balances overdue by more than 90 days who are NOT paying 
interest). When using the Intersection and the Union operations, the sets are interchangeable. 
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21. Document Editor 
TimeManager has its own built-in document editor. The document editor module provides a 
quick and easy way to generate form letters and merge your client-specific data into the 
letter. This feature can be used for collection letters, class action letters, engagement 
letters, change of address or any other form letter you require. 

21.1. Creating a Document 
To create a new document destined for clients, you must first be in the client table. Click 
“Client” on the palette if you are not already in the client table. Next, click Tools on the 
menu bar and select Special Functions from the drop-down menu. The Special Functions 
window will appear. Highlight Document Editor and click OK. 

 
The Report Manager window will open. Click the New button on the bottom left corner. 
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Begin by assigning a title to your document by typing the document name in the Report 
Name field. Your document can include a header, body and footer. To view the header and 
footer, click View above the task bar and select Page from the drop-down menu. You will 
now be able to see the header, body and footer section of the document. The dimensions 
of all three sections can be modified by clicking within the section and adjusting the 
dimensions on the width and height rulers. Slide the margin markers along the rulers to 
change the document’s width and height. 
 
Your document may include both static (text that remains the same for every printed letter) 
and dynamic (text that changes for each printed letter) content. The static text may be 
typed or pasted directly into the document body. To add dynamic content, leave the cursor 
where you want the text to display. Click on Insert on the taskbar and select 4D 
Expression. The Insert 4D Expression window will appear. 
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Select the field you wish to insert from the list and click OK. The field will appear on the 
document as «[Table]Field». When the document is printed, these expressions will 
be replaced with data from your database. The following is an example of a 
document that includes dynamic content: 
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The following is the same letter as it appears once it is populated with data from 
the database: 

 
In addition to fields from the database, you may also insert automatically the date and time, 
along with page numbers. Both of these functions are found in the drop-down menu when 
you click Insert on the task bar. 
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Once you have completed the document, click the Description tab at the top of the Report 
Manager. Compose a brief description of the document and its purpose. Click the Save 
Report Template in the bottom right corner. Once saved, you can click the Done button in 
the bottom right corner of the Report Manager. 
 

21.2. Printing a Document 
To print a document you have created in the Document Editor, you must first select the 
records that will be included the document merge. In other words, if your document is a 
letter announcing your move to a new address, you can simply open the client table and 
select all records. However, if your document is a reminder letter for outstanding invoices, 
you must first run a query of all clients with overdue balances (see Chapter 15). Once you 
see the results of your query in the list view window, click the Document Editor icon on the 
task bar. 

 
The Document Manager window will appear. 
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 Select the letter template you wish to use from the column on the left. Click the Preview 
button if you wish to see the completed letter before printing. Otherwise, click Print to 
proceed.  
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22. Import Export Editor 
TimeManager’s Import Editor can incorporate third-party data into an existing database. 
Conversely, the Export Editor allows users to take data from the TimeManager and convert 
it into a format used by other programs such as Microsoft Excel or Quickbooks.  

22.1. Importing a File 
To bring new records into your TimeManager database from an outside source, it is 
recommended that you first convert the data into tab delimited file. To convert your data, 
run “Save As” in your program and select tab delimited text (.txt) as the format.  
To launch the Import Editor in TimeManager, click File on the menu bar and select 
Import… from the drop-down menu. The Import File window will appear displaying all the 
files available on your computer and network. Select the file you wish to import and click 
the Open button on the bottom right corner. 

 
The Import Editor window will now appear. This window is where you can determine which 
columns will be loaded into your existing TimeManager database. You can also rename the 
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columns imported file so that they match the existing data. In the example below, the first 
column containing client numbers is not set to import, as indicated by the “Not” at the top of 
the column. This can be changed by clicking on the downward-facing arrow and selecting 
the proper field from the drop-down menu.  

 
In this same example, the third column is marked as Nickname and must be changed to 
Address 1 and the subsequent columns must also be changed. You can make this change 
by clicking on the downward-pointing arrows. Since it is not necessary to import the original 
column headers, you must instruct TimeManager to not import the first line of records. You 
can do this by clicking on the Header tab on the top right side. 
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In the field “Import from Line #:” enter the number row from where you would like the data 
import to begin. In the example above, entering 2 automatically deletes the redundant 
column headers that were in line 1.  
Once all the columns are appropriately named, click Import to bring the records from the 
outside file into your TimeManager database.  
 
Warning: Make sure that your client numbers are unique. 

22.2. Exporting a File 
Before launching the Export Editor, you must first select the records you wish to export. For 
example, if you want to export a list of all clients, you must first click Client on the palette. 
However, if you want to export a more tailored selection of data, you must first run a search 
or a query. Once you are looking at a list view of the records you wish to export, click File 
on the menu bar and select Export… from the drop-down menu. The Export Editor window 
will appear. Select the data you wish to export by double-clicking on the fields in the left 
window. Once you double-click, they will appear below. You can also add fields by clicking 
the single blue downward-pointing arrow button. Click the double blue arrows to add all 
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fields. Use the single red arrow to remove a field and the double red arrows to clear all 
selections and start again. 

 
Once you have selected all the fields you wish to export, click on the second tab on the top 
right to edit the header. 
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Here you can add a title for the file and indicate whether it should include column titles 
and/or line numbering. Next, assign a title set a destination for the exported file by clicking 
the Browse button in the top right corner.  Enter a name for the file in the “Save As” field 
and select where you want the file saved.  
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Now click the Export button in the bottom right corner.  You can verify the exportation of 
the data by checking the destination you assigned in the Export Editor. Below is an 
example of data that was exported from TimeManager and opened using Microsoft Excel. 
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23. Structure Editor 
TimeManager gives the database administrator the capability to change the name of a field 
header using the Structure Editor. For example, if your firm is based in Canada, you may 
wish to change the header name of the “State” field to “Province” or “Zip” to “Postal Code.” 

23.1. Changing the name of a field in the Record View 
To launch the Structure Editor, click File on the menu bar and select Administration from 
the drop-down menu (this option will only be available to a user logged in as Administrator). 
The Administration window will appear. Select Structure Editor and click OK.  

 
The Structure Editor window will appear. Click the Fields tab at the top of the window. 
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Select the Field name you wish to modify from the list Fields in View on the right. Click the 
field name and then update the field name in the Table Alias field. 
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Type the new field header in the “View Alias Fieldname” field. In the above example, the 
State abbreviation “St” has been changed to “Prov” for Province. Click OK when complete. 
You will return to the Structure Editor. Perform any other changes you wish to make. Once 
complete, click OK.  

23.2. Changing the name of a field in the List View 
To change the header names in your List View screens (the screens which appear when 
you click “Client,” “Slip,” “Invoice,” etc. on the palette), you do not need to launch the 
Structure Editor. Simply open the List View window you want to modify and click the gear 
icon in the top right corner. 
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Select “Edit View” from the drop-down menu that appears.  The Edit View window will 
appear. 
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Highlight the field you wish to modify in the “View Fields” window and enter your edits in 
the Column Settings field below. In addition to changing the name of a field, you can also 
modify the font.  
 
This same tool can be used to add or remove additional field columns to your List View.  
To add a field, select the fields you wish to add from the Database Fields window and click 
the Add button. You can arrange the order of the fields in the View Fields window by 
selecting and dragging them into the desired order.  
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To remove a field, select the field you wish to eliminate in the View Fields window and click 
the Remove button.  
 
Note: Clicking the Clear button will erase all fields in the List View window.  
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24. Sequence Number Editor 
Sequence numbers are unique primary keys that are used by TimeManager to keep all 
related records in proper numeric order. For example, if the highest client number is 217 
and you create a new client record, it will automatically be assigned the next sequential 
number, 218. It is important to understand how to assign sequence numbers in case you 
have accidentally deleted a record and wish to re-establish the deleted record without 
creating a higher sequence number. For example, if you accidentally deleted slip 55, and 
now wish to recreate it, you must use the Sequence Number Editor, otherwise the 
recreated slip will just be assigned then next highest slip number. 

24.1. Changing Invoice Numbers 
To launch the Sequence Number Editor, you must be logged in as Administrator. Click File 
on the menu bar and select Administrator from the drop-down window.  

 
The Administrator window will appear. Select Sequence Number Editor and click OK. The 
Sequence Number Editor window will appear. Select the table you wish to edit. For 
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example, if you want to renumber a slip, select Slip Table Key, if you want to renumber a 
Timekeeper, select Timekeeper Table Key. Click the Edit button. 

 
 
The Edit Sequence Number window will appear. In the following example, the next slip to 
be created will be assigned the number 20,087. 
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If slip number 20,080 was accidentally deleted and needed to be recreated, you would 
enter 20,080 in the Next Number field and click OK. 
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Click OK. The Sequence Number Editor window will appear. If you have no other numbers 
to edit, close the window. You will now recreate the record you deleted. Once you have 
recreated the record with the lost sequence number, it is important to immediately return to 
the sequence number editor and reset the next number back to the original sequence (in 
the above example, this would be 20,087). If you forget to do this, the next time you try to 
create a new record, you will get an error message because there will already be a record 
in occupying the next sequence number. For example, if you neglected this final step, the 
next time you tried to write a new slip, TimeManager would try to assign it the number 
20,081, which is already assigned to an existing slip.  
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25. Modify Record Feature 
The Modify Record feature is a powerful operation that can automatically make changes in 
thousands of records all at once. For example, if a timekeeper leaves your firm and all of 
his matters are assigned to a new timekeeper, you can use the Modify Record feature to 
reassign every slip from those matters to the new timekeeper in one single operation. 
Warning: The Modify Record Feature cannot be undone, once executed. It is critical 
that you backup your data before running this operation. 

25.1. Running Modify Record Feature   
To launch the Modify Record Feature, you must first select the records you wish to modify. 
You can do this by running a Query operation. For example, if you want to reassign the 
slips from Timekeeper 21 to Timekeeper 36, you must first click Slip on the palette. Once 
the Slip List View window is open, click the Find icon and run a search for all records 
where Timekeeper No equals 21. The results will appear in a list view window. In the 
example below, this includes 1,192 slip records. 
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Now click Enter on the Menu bar and select Modify Records… from the drop-down menu. 
The Modify Records window will appear. Select the field you wish to modify. In this case, 
the field to modify is Timekeeper No. and the new value is 36. 

 
After you click OK, a confirmation window will appear. Pay close attention to the number of 
records which are about to be modified. 

 
Once you click OK, a progress window will appear. Depending on the number of records to 
modify, this may take several minutes. 
 
 

 
Once the operation is complete, the selected records will now display the modification. 
Note, in the example below, all the slips now show ID NFF (Timekeeper 36) instead of ID 
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JSS (Timekeeper 21). 
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26. LEDES Billing 
The following chapter is relevant only for firms using the Legal Electronic Data Exchange 
Standard 

26.1. LEDES Billing Defined 
LEDES billing is a standardized file formatting system that allows for the electronic 
transmission of invoices from a law firm to corporate clients. 

26.2. Creating a LEDES Billing File 
To create a LEDES file, first select the invoice(s) you wish to convert. If you are only 
converting one invoice, double-click on the invoice in the lnvoice list view window to open 
the record. If you are converting multiple invoices, highlight the desired invoices and click 
Select on the menu bar and select Show Subset from the drop-down menu. Click on Tools 
on the menu bar and select Special Functions. The Special Functions menu will appear. 
Select Export LEDES File. 
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After clicking OK, a Save window will appear. Designate a file name for the LEDES invoice 
and select a save destination. 
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Once you save the file, you will be prompted to enter the start and end date for the invoice. 
You may also elect to include headers that will show the title of each field.  

 
 
Click OK. The following window will appear to confirm the LEDES export. 
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To view the LEDES billing, open the file in a spreadsheet program such as Microsoft Excel. 
Below is a sample of the LEDES file from the example executed above. 
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Column	
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